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=============== New Features/Changes ===============

• We have found that a lot of critical issues that happen with Fusion Server could be 
avoided if we knew earlier what was going on with the server. So we have implemented 
an early warning system which will allow us to give an enhanced level of support in 
preventing problems before they happen. The way this works is that your server will 
occasionally send information to us regarding its state. Examples of information being 
sent are: data file size, data file drive percentage full, whether a backup happened 
correctly, whether the data file verification happened correctly, what version of Fusion 
is running, how many crashes have occurred recently, your cache size and the 
data:cache ratio. When something goes wrong or exceeds a certain threshold, we are 
notified immediately so we can correct things before they become a real problem. Also, 
in the past, after a crash you were asked to enter some information about the crash. 
This used to be stored on your server so we could look for patterns. Now this will be 
sent directly to us so we can find patterns earlier. So please take the time to enter 
something descriptive when this happens.

For billing purposes, Fusion also sends us the average head count over the last 365 
days. Note that it never sends us the current head count. We want to assure you that 
none of your actual data is being sent to us. We really have no interest in that. With the 
exception of the average head count, only things regarding the state of your server's 
health are sent to us. If anyone is nervous about this and would like to look at the raw 
information being sent, please contact us and we will be happy to send it to you. 
Please note that the license agreement has been updated to reflect this.

This new functionality also makes it possible to automatically renew license keys, so 
that has been implemented. In addition, if that fails for some reason, the Auto Refresh 
Key Now button in the License Key window also works now. New deployments who 
have obtained a launch code will also be able to automatically obtain a license key.

One related change is that you will now be asked to give a reason for shutting down 
the server before doing so and this message will be sent to us. Please don't ignore this. 
There are a couple occasions when it is fine for a server to be shut down, but they are 
rare, so when a server is shutdown we are immediately notified via text message and 
will assume something is very wrong unless we can tell from your message that things 
are normal.

• Significant changes have been made regarding the Events list window which used to 
show bunk call, pen move, weight change, and bunk call notes events. The Events list 
window no longer exists and if it was used in reports, either directly or as an inline 
report, you will need to modify those reports. This window has been replaced by 
dedicated list windows which are more fully explained below. This will make it easier to 
search and report on these kinds of events.

• Bunk Calls. The Bunk Call Events window shows each bunk call that has been made 
(each time the Accept button is clicked). As before, it shows the ration and bunk call. 
But new fields have been added so you can also see what the ration and bunk call were 



before Accept was clicked (this information is only available starting with this version—
it can't be filled in historically). You can also add a note as part of the bunk call using a 
new button on the Bunk Call/Feed Delivery window and the Daily Feed Detail window. 
Use that to add a note before you click the Accept button. The bunk call graph will 
show a yellow triangle on any day that has a bunk call note.

One happy side affect of this change is that Fusion is now smart enough during 
syncing so that a bunk call made earlier in the day in one place will not override a later 
bunk call made somewhere else no matter how the syncing takes place.

The Bunk Call Events window is available from Fusion Core --> Events, Fusion Feed --
> Events, and from the Options button in Fusion Truck.

• Change Pen Weights. Similarly, each time you change the weight of all or part of a 
pen it is recorded in the Change Pen Weight Events window. In this version we also 
start tracking what the weight was before the change was made.

The Change Pen Weights Events window is available from Fusion Core --> Events, 
Fusion Chuteside --> Events, and from the Options button when using a touchscreen 
at chuteside.

• Move Events. Whenever animals are moved, the event is recorded in the new Move 
Events window. In addition to the information that used to be recorded for a move, we 
now track the pen's count before the move and the feed weight and percentage that 
was moved. You can also now open the Animal List window as a child window to see 
which animals were linked to each move.

The Move Events window is available from Fusion Core --> Events, Fusion Chuteside 
--> Events, and from the Options button when using a touchscreen at chuteside.

• Using list windows on a touchscreen can be difficult. Starting with this version, the 
gear icon, the magnifying glass in the search object, and the search object itself all 
automatically detect whether you are using a touchscreen and change their interface to 
make it easier to use with touch. Some other interface areas in Fusion which normally 
present a popup menu also do this now. Even the Advanced Find and Advanced Sort 
windows will change when on a touchscreen. This means that some of the functionality 
that was reserved for the office can now be used more easily at chuteside.

• The Animal List window now senses when it is on a touchscreen and will be visually 
different to make it easier to use for finding animals and viewing their history. The old 
functionality for finding animals via View History has been replaced by the enhanced 
Animal List window. The menus have been updated to reflect this.

• Entity Chooser changes. The "Entity Chooser" is the window you use to choose a pen, 
an animal count, and link animals when moving animals, changing pen weights, and 
creating an out cohort. Especially for linking animals, this window was difficult to use, 
so we have completely redesigned the way this works. Windows where you need to 
choose an entity now detect whether you are using a touchscreen and change their 
interface to suit either touch or mouse and keyboard. This should make it easier to use 



these windows in the office. When you need to link animals, you now have several 
options to choose from which you can explore. For example, Try Auto Linking will 
automatically link the animals if the number of animals Fusion thinks are in the pen 
match the count you have entered. By separating out different ways of linking, we can 
make each way simpler and more powerful than the old Entity Chooser and we can 
more easily add new functionality in the future.

• You can now link animals to in cohorts. This can be done when an in cohort is 
created (with the normal window or the Simple In Cohort window) and it can be done 
later on as well. The only restriction is that the animals have to be current. You can 
view the linked animals from within the in cohort edit window or by opening the 
Animal list window as a child window to the In Cohort list window.

• Because of the new way of choosing entities, the Move Animals and Change Pen 
Weight windows have changed somewhat and, as noted above, will look and behave 
differently when on a touchscreen.

• Two new windows for creating out cohorts on a touchscreen have been added. The 
Simple New Out Cohort window should be used for regular out cohorts such as animals 
going to slaughter and contains just the fields necessary to get the cohort created, 
similar to the Simple In Cohort window. The other fields can be filled in later at the 
office. Similarly, the Simple New Death Out Cohort window is focused on just adding 
deaths at chuteside. Fusion ensures that exactly one animal is involved in this kind of 
out cohort. There is also a new preference (Out Cohorts area) that allows you to force 
the user to link an animal for deaths.

• The old Out Cohort edit window has also changed. As it should only be used in the 
office it is now more friendly for keyboard and mouse usage. Also, a new field for 
recording the vet who did the post mortem has been added.

• Fusion now tracks individual animal movements when they are linked during moves 
or during chuteside jobs. You can view the movement history as a child window from 
the Animal list window as well as in the Animal History window. One thing this allows 
is more accurate feed related withdrawal tracking for individual animals, as long as 
animal linking is kept up to date. More on this below.

• The way withdrawals are handled has completely changed and needs to be 
understood to be used correctly. There are two things that will give an animal a 
withdrawal date—being fed a ration with an ingredient that has a withdrawal on it and 
being given a drug that has a withdrawal on it.

Each pen (the physical pen) keeps track of the count, weight, feed, etc. for each day in 
the Pen Day Summary list. Fusion now keeps track of the withdrawal date based on 
feed given to that pen that day. You don't normally have to worry about this, but if you 
were to change the withdrawal on an ingredient and wanted this to take affect 
retroactively, you would need Fusion to recalculate this base information. You do this 
by selecting the pens you are interested in in the Pen list window and choosing the new 
Recalculate Withdrawals menu button. This can be rather slow, so you are asked to 
enter a date range to recalculate for.



The Animal list window now has three withdrawal fields—one for drugs, one for feed, 
and an overall one. After certain events and each night, these withdrawals are 
recalculated for each animal. You can also select a group of animals and choose the 
new Recalculate Withdrawals For Selected Animals from the Modify menu button to 
force this recalculation any time you want (for example, after changing the withdrawal 
time on a drug).

The drug withdrawal field if fairly straight forward and behaves as it used to. It is 
simply based on drugs given to the animal during chuteside jobs. The feed withdrawal 
field is calculated by looking up the animal's movement history to see what pens it has 
been in. Fusion then looks up the pen's withdrawal for each date the animal was in that 
pen. On the day an animal is moved, Fusion will assume it ate feed from both pens on 
that day. This means that if you are linking animals during moves, the feed withdrawal 
for animals will now be accurate.

Finally, the overall withdrawal field is calculated based on the drug and feed 
withdrawals. So, if you are linking animals, you would normally just want to use the 
overall withdrawal field. If you are still not linking animals during moves, you will need 
to just rely on the drug withdrawal field.

Besides being able to ask Fusion to recalculate an animal's withdrawal whenever you 
like, Fusion automatically recalculates it every time an animal receives a new drug as 
well as every night at midnight for all current animals. This means that the only time a 
withdrawal might not be accurate is if the animal was fed a ration with a withdrawal on 
it today. In that case you would want to have Fusion recalculate before reporting 
withdrawals.

Note that the old way of figuring out feed withdrawals was based on following a pen's 
bunk call graph history to come up with a withdrawal date and that this had to assume 
the animals in the pen had all stayed in the pen the whole time and that the graph 
history was correct. This way of calculating feed withdrawals has been replaced by the 
way described above everywhere in Fusion. Now, when you want to see withdrawal 
information for a pen or a lot, Fusion simply figures it out based on the withdrawal 
information of the animals it knows are in the lot or thinks are in the pen. You can 
decide whether to include the feed withdrawal information in these instances.

Please also note the following related changes: The Animal History window now shows 
all three withdrawal types. The Lot Center withdrawal fields now reflect the new way of 
calculating withdrawals where the lot level withdrawals are just obtained from the 
animal level withdrawals. The Withdrawal column in the Animals section of the Lot 
Center window now reflects the animal's Overall withdrawal, not the Drug withdrawal 
(it is now better to use the new Withdrawal Window, explained below, instead of this 
column anyway). Similarly, the Pens area Withdrawal column is now based on the 
animals thought to be in the pen. If you have any Detail Reports from the Lot Center 
window that include the Pens area, please note that the option for this section has 
changed and you will need to make sure it reflects whether you want to include feed 
withdrawal information now. Finally, note that the Withdrawal shown for an animal 
during a chuteside job has not been changed at this point--it still only represents the 



drug withdrawal.

• Withdrawal Window. A new window for viewing and reporting on withdrawals has 
been created and is available from Fusion Chuteside --> Utility --> Withdrawals, 
Fusion Office --> Yard Reports --> Withdrawals, the chuteside touchscreen menu 
window Options button, and from the Options button available during a chuteside job.

The window will break down withdrawal information by either lot or pen and you can 
decide what date you are interested in calculating the withdrawal information for. For 
example, you could have Fusion figure out what the withdrawal situation will be in a 
week from now. You can also decide whether to include feed withdrawals.

After calculating the report, Fusion will show you the headcount for each pen as well as 
the animal count. Theoretically these should be the same, but if animals aren't always 
linked during moves these numbers could be different. Showing both of them will help 
indicate how accurate the withdrawal information may be (remember, all withdrawal 
information is based on the withdrawal information of the animals Fusion thinks are in 
the pen).

Fusion also shows the "Hold Count", or the number of animals that have withdrawals as 
well as the dates involved. Any of the columns can be sorted. You can then copy to the 
clipboard for pasting into a spreadsheet or you can print the information as a report.

If you double-click on a pen (or select a pen and click View Animals), you will see a list 
of animals Fusion thinks are in the pen sorted so the ones with withdrawals are shown 
at the top. From there you can view individual animal histories to find out where the 
withdrawal came from or search and print reports as with normal lists.

• You can now link from the Pen List window to the Pen Day Summary list based on the 
bunk call graph. This will be useful for inline reports where you want to print daily 
summary information for a pen in the same way the bunk call graph does—even 
pulling information from other pen's histories if the animals where in those pens 
before. Another use would be to open a child window and sort by Withdrawal Date to 
see what the pen's withdrawal is based on the old way of figuring out feed based 
withdrawals.

• Many new fields have been added to track animal level information, some of which 
are explained below. As a result, the Animal History window has changed significantly 
to show these new fields. There is a new lock icon in this window that allows many of 
these fields to be edited. Besides the new fields, you can now view and edit the 
animal's movement history and the animal's withdrawal history so you can find where a 
withdrawal is coming from. 

The intention of this version was to get the new animal fields working and make it so 
you can at least edit them manually or import them from a file. Future versions of 
Fusion will build on this so that many of these fields can be entered during a chuteside 
job as well. Note that the Animal List window has changed significantly to reflect the 
addition of these fields.



• The Animal History window used to calculate and show the drug and input dollars 
into an animal so far. We have made some changes and extended this a bit. First, 
instead of calculating this information when opening the Animal History window, we 
now calculate these values every midnight and store them in fields. This means that 
the data is only valid as of the previous midnight, but it also means that you can now 
view, query, sort, etc. these fields in the Animal List window. We have also added new 
fields which estimate the dollars into an animal for feed and yardage as well as total 
dry matter consumed per animal. Obviously, the feed fields are only estimates and 
simply use the new ability to track what pens an animal has been in. It then just splits 
the feed consumed by the pen among the animals simply on a per head basis.

Something that can affect this is two new fields for the Feed Delivery list window 
showing the cost and bill at values for the delivery. These values are recalculated every 
night as well for all feed deliveries within the last 90 days. We go back 90 days to make 
sure feed delivery pricing is updated after you have changed ingredient pricing. 
Normally this should be good enough, but if you need certain feed deliveries to have 
their pricing updated right now, you can select them in the list and ask Fusion to 
recalculate the dollar values. Note that the new feed related animal dollar fields 
actually use these feed delivery fields in their calculations, so keep this in mind if you 
need to manually update the animal dollar values as well.

There are additional animal fields that are also calculated every midnight, but they are 
not fully listed here as there are too many.

• Fusion will now track up to five implants right in the Animal list window, including 
the date and weight at implant time. That ways this works is that when a chuteside job 
is processed, if an animal received a drug which Fusion thinks is an implant, it will scan 
through the five implant fields and add it to the next available field for the animal. The 
important thing to understand is how Fusion detects whether a drug is an implant or 
not. It simply looks at the drug's units. If the unit for the drug is "implant", then it 
considers it an implant.

This should normally be fine, but if you have any drugs where you were using this unit 
differently, you will want to change them before upgrading to this version. If anyone 
has a good case where detecting implants based on the unit is not valid, please let us 
know and we will do something different in the future.

• Fusion now allows you to have several series of custom fields for animals. You can 
define the labels for the fields in the Preferences window (Animal Fields section). For 
the custom weight fields, you can now specify when you start a chuteside job that you 
want a certain custom weight field to be filled based on the weight from the job. Note 
that Fusion has a dedicated field for the In Weight which is filled when an animal is 
created, so you probably don't want to use a custom weight for that.

If you choose a custom weight field for a job, and if there is already a weight in that 
field for an animal, it will be replaced by the new weight.

• You can now import information from CSV and Tab-delimited files to many of the 
animal fields. For example, if you get a file back with ultrasound or carcass data in one 



of these formats, Fusion call pull that information in and save it to the correct animal. 
To do this, use the Animal list window and choose the new Import From File... option 
from the Modify menu button. You will be asked to choose a file and then shown the 
contents of the file. You can then assign which columns will import into which fields. 
You also tell Fusion which columns hold the ID information needed to look up the 
correct animals during the import. If you import the same type of file often, you will 
want to save the setup information as a preset so it can be recalled later.

Fusion will also automatically detect B5 type files from Cargill and import them to the 
carcass related fields.

• A new function under the Modify menu button in the Animal list window will have 
Fusion list all animals with duplicate RFIDs or custom IDs.

• The setup window used during a chuteside job is now a regular window so other 
windows can be viewed in front of it if you want. Also, the Finished Job—Process 
button has moved to the left a little ways so it is easier to resize the window without 
accidentally hitting the button.

• The CCIA Import event has been added to the possibilities from the Animal List 
window. Also, if Auto Move In is turned on in the preferences, Fusion will now check to 
see if the RFID tag is from Canada. If it is not, it will first send CCIA an Import event 
and then the Move In event as per CCIA's request.

• When moving animals, Fusion now checks to make sure you aren't moving animals 
that belong to an in cohort that hasn't been assigned a lot yet.

• It is no longer necessary to specify or worry about sublots during a chuteside job.

• Fusion now keeps track of whether a load or feed delivery was manually entered. It 
also keeps track of load and delivery edits. You can view/print this information from 
the Loads list window and the Feed Deliveries list window. You can also use the Daily 
Feed Detail window to see this information. Edited loads and deliveries will show up in 
red in the View By Load tab. If you right-click such a row, you will have the option to 
see the change history.

Note that Fusion has no record of whether edits have been made to any loads and 
deliveries made previous to this version. These will have an "unknown" status to 
distinguish them from ones Fusion knows whether an edit has happened.

• The Daily Feed Detail window now has some additional columns in the Loads and 
Ingredients lists which make it easier to see what loads were blended and how much of 
each ingredient was blended.

• Added a new advanced find field to the Scale Ticket list window called Reconciled 
Status. This can be used to find all scale tickets that either have been or have not been 
reconciled. If you want to restore the old functionality of the window showing only 
unreconciled tickets when it opens, you can use this new field to create an advanced 
find showing only unreconciled tickets and then set that as the default search when 



opening the window.

• Added a new advanced find field to the In Cohort list window called Reconciled To 
Lot Status. This can be used to find all in cohorts that either have been or have not 
been reconciled to a lot yet. If you want to restore the old functionality of the window 
showing only unreconciled cohorts when opened, you can use this new field to create 
an advanced find showing only unreconciled cohorts and then set that as the default 
search when opening the window.

• Command-N (Mac) and Control-N (Win) can now be used as a shortcut in list type 
windows to create a new item. For example, in the Scale Ticket list window, typing the 
shortcut will open a new scale ticket window so you don't have to use the mouse to 
click on the New button or choose New Scale Ticket from the menu. Remember that 
Command/Control-W automatically saves and closes a window. This combination 
should make repetitive entry faster because it can all be done from the keyboard.

• The Pen list window combined the two menus for changing the pen drive and display 
ordering into one menu named Change Ordering....

• The Animal List window can now use Advanced Find on the Current Pen column.

• When Fusion Truck tries an auto sync and fails, it now asks whether you want to try 
again before moving on to another load or delivery.

• If Fusion is already connected to a port (RFID reader, temp probe, etc.) and the 
Physical Computer Management window is opened, the port that is currently in use will 
not show up in the list of available ports (because it isn't available—it is in use). This 
caused some confusing situations. In the last version, this was changed for remote 
displays so that even ports in use by Fusion in a different window still show up as 
available in the port list. This version extends that to RFID readers and temperature 
probes.

• It used to be that you could maximize the scale indicator window by accidentally 
brushing the top of the window. It was often very difficult on a touchscreen to get it 
back to the right size. Now it is not possible to maximize the window anymore.

• We've seen several times when someone on a touchscreen accidentally makes the 
entire Fusion window (the MDI window) too small to use. In some situations it can be 
difficult to maximize the window to a useable size. Fusion now periodically checks to 
see if the MDI window is too small and will automatically resize it when needed. 
(Windows only, doesn't apply to the Mac.)

• We've added some experimental functionality to the File menu (or Options menu on 
touchscreens) called "Toggle MDI Transparency" which applies to Windows computers. 
Using this will make the main Fusion window (the MDI window) transparent so you can 
see the Desktop or other applications in the background. In a way, this will make 
Fusion on Windows more Mac-like in that you can more easily deal with multiple 
applications at the same time. As mentioned, this is experimental so we'd like your 
feedback to know if anyone finds this useful and how well it works for you.



• As we add new list windows to Fusion, we are starting to keep them fairly simple. 
This is because the fewer columns that are shown, the faster Fusion will be. Please 
don't forget that you can use Advanced View to explore the possible columns and 
change the way lists look for everyone or just for you.

• Fusion Server can now be set up to copy its backup files to other locations (external 
drive, network drive, etc.) after the backup has completed. This must be set up with 
Fusion Server itself.

• The Risk Analysis Export functionality has been renamed to Lot Info Export and the 
information which can be exported has been expanded significantly. For those who 
have used it in the past for risk analysis, it will continue to work as before, but risk 
analysis is now only a subset of what it can be used for.

• Fusion Truck now verifies its datafile and index file at each launch and will warn you 
if there are problems. This should only take a few seconds each time.

• When starting a chuteside job, there is now an option to turn on RFID logging. This 
should only be used if you are having trouble with your RFID reader as this creates a 
file on the desktop that can be used for debugging purposes.

=================== Bug Fixes ===================

• The New Value column of the Weight Class Attributes window would not display or 
print properly. This is fixed.

• When printing the Death Loss Percentage column from the Lot Center window, if a 
footer was included the footer value was formatted incorrectly. This is fixed.

• Double-clicking on an empty row in a list window would cause a new item window to 
show up. This is fixed.

• When using a negative inventory adjustment, the calculated dollar values could be 
negated. This is fixed.

• Several fields could cause an error when used in advanced print reports. This has 
been fixed for as many fields as we are aware of.

• The Drug Withdrawal information in the Basic Info detail section of the Lot Center 
window would take into account animals that were already shipped. For example, if a 
lot was clean except for one animal, and that animal was shipped, the lot would still 
show a withdrawal date because of the shipped animal. Now only current animals are 
looked at when calculating the drug withdrawal.

• When adding ingredients to a ration, if the ingredient name had some special 
characters in it it might display funny in the popup menu. This has been fixed.



• For some time now you could not use advanced find with the Buyer column for the 
Out Cohorts window with correct results. This is now fixed.

• When printing the Cattle area from the Inventory Summary window, the Begin Value, 
In Dollars, Out Dollars, and End Value columns could get mixed up. This is fixed.

• When blending a load into another load with a different ration where the new ration 
has some ingredients that the first ration did not have, and where these ingredients are 
higher in the loading order, the blend amount could become incorrect. This is fixed. 
This did not affect actually building a load or billing, but it could affect inventory. Upon 
upgrading, Fusion will rebuilt the inventory for all commodities to reflect this fix.

• In the Daily Feed Detail window, under the Usage Summary tab, the Total Loaded 
columns used to add up full loads, even if the load was blended into another load. 
Fusion now accounts for blending here so the total loaded vs total delivered should 
reflect reality much closer.


